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Installing Norstar Voice Mail Desktop Accessories

Introduction
Norstar Voice Mail Desktop Accessories includes:

• Norstar Voice Mail Desktop Messaging

• Norstar Voice Mail Mailbox Manager

• Norstar Voice Mail Operator Manager

Norstar Voice Mail Desktop Messaging
Norstar Voice Mail Desktop Messaging allows you to create and receive Voice
Fax messages on your personal computer (PC).

Norstar Voice Mail Mailbox Manager
Norstar Voice Mail Mailbox Manager allows you to manage all the mailbox 
features and functions that are available through  ƒ·°⁄ from your 
PC. Norstar Voice Mail Mailbox Manager gives you the ability to:

• Initialize your personal mailbox

• Record your primary, personal and alternate greetings

• Select your primary, personal and alternate greetings

• Change your spoken name that appears in the Company Directory

• Change your Target Attendant

• Set up and maintain Off-premise Message Notification

• Set up and maintain Outbound Transfer

Norstar Voice Mail Mailbox Manager also gives the System Administrator acc
to Information Mailboxes, the System Administrator Mailbox, the Business Op
status tab and the record Company Greetings tab.
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Norstar Voice Mail Operator Manager
Norstar Voice Mail Operator Manager allows the System Administrator to man
the Norstar Voice Mail features and functions that are available through  
ƒ·°¤ from a PC. Norstar Voice Mail Operator Manager gives th
System Administrator the ability to:

• Change the Operator password

• Change the Business Status to open or closed

• Enable and disable the system attendant (Operator)

• Change the extension of the system attendant (Operator)

• Enable and disable the Norstar Voice Mail Call Answer feature (Automate
Attendant and call answering)

Installing the Norstar Voice Mail Desktop Accessories software
The Norstar Voice Mail Desktop Accessories software suite has both server a
client components. The server part exists on the Norstar Applications Module
(NAM). The client part of the Norstar Voice Mail Desktop Accessories softwa
must be installed on the PC of each subscriber. 

This guide describes the procedures for installing the client part of the Norsta
Voice Mail Desktop Accessories software. All three Norstar Voice Mail Deskt
Accessories features are installed in a single procedure.

For Norstar Voice Mail Desktop Messaging to be functional, the server part o
Norstar Voice Mail Desktop Messaging, called a seat license, must be enable
the Norstar Applications Module (NAM). The Norstar Voice Mail system come
with two Norstar Voice Mail Desktop Messaging seat licences that have been
factory enabled. With two seat licences enabled, a maximum of two PCs runn
the Norstar Voice Mail Desktop Messaging software can be connected to the s
at any one time. 

Prerequisites for installing Norstar Voice Mail Desktop Accessories software on a 
PC running Windows NT® 

Before you can install the Norstar Voice Mail Desktop Accessories software o
PC running Windows NT®, you must have Administration privileges. The 
installation of Norstar Voice Mail Desktop Messaging requires the registration
several components in the Windows® registry. If you log on as a user without 
Administration privileges and try to install Norstar Voice Mail Desktop 
Accessories, the installation will fail. 

After Norstar Voice Mail Desktop Accessories has been successfully installed
remove the user’s Administration privileges.

Microsoft, Windows, Windows NT and Outlook are registered trademarks of Microsoft Corporation in the U.S. and/or other countries.
Desktop Accessories Software Installation Guide P0908823 Issue 01
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PC prerequisites
Before you can install and use the Norstar Voice Mail Desktop Accessories, y
PC must meet the following requirements:

• your PC must be running either Windows® 95, Windows® 98 or Windows NT® 

• your PC must be connected to the same TCP/IP network as the server

• Microsoft® Exchange*, Microsoft Outlook® or Windows Messaging client 
software must be installed on your PC

• your PC will require at least 5 MB of free disk space to install the Norstar Vo
Mail Desktop Accessories software

*Microsoft Exchange versions 4.0.834.839, 4.0.837.6 and 4.0.835.1374 are not compatible with 
Norstar Voice Mail Desktop Accessories. You must upgrade to a later version of Microsoft Exchange 
before attempting to install the Norstar Voice Mail Desktop Accessories software.

Installing the Norstar Voice Mail Desktop Accessories 
To install the Norstar Voice Mail Desktop Accessories software:

1. Exit any Windows® programs that are running.

2. Place the Norstar Voice Mail 4.0 Documentation and Client Software CD-
ROM in the CD-ROM drive of your computer.

3. Start the Norstar Voice Mail 4.0 Documentation and Client Software CD-
ROM and navigate to the Norstar Voice Mail 4.0 main screen.

4. Click on Client Software.

5. Click on Desktop Messaging Install and follow the instructions that appear 
on the screen.

After the Norstar Voice Mail Desktop Messaging client software is installed, 
continue with "Configuring the Messaging Application Program Interface (MAP
profile" on page 6. You must configure your PC MAPI file before using the Norsta
Voice Mail Desktop Messaging software.

Note: If your computer is not equipped with a CD-ROM drive, ask your Syste
Coordinator to create Desktop Messaging Install diskettes from the 
Norstar Voice Mail 4.0 Documentation and Client Software CD-ROM.
P0908823 Issue 01 Desktop Accessories Software Installation Guide
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Configuring the Messaging Application Program 
Interface (MAPI) profile

Before using Norstar Voice Mail Desktop Accessories software, you must 
configure the messaging profile on your PC. 

Although most PCs have only one messaging profile, some PCs can have mu
profiles, especially if the PC is routinely shared by several users or is a laptop
that is connected to different networks. These instructions assume that your P
a single messaging profile. If you have multiple messaging profiles, you must
repeat these instructions for each profile.

The windows that appear in this section are examples of configuring the Mess
Application Program Interface (MAPI) profile. Folder and file names vary 
depending on the configuration of your PC.

To configure the MAPI profile:

1. On the taskbar, click the Start button, point to Settings and then click 
Control Panel.
The Control Panel window opens. 

2. Double-click the Mail and Fax icon.
Your Properties dialog box appears.

3. Click the Add button. 
The Add Service to Profile dialog box appears.

4. Click Nortel Address Book and then click the OK  button.

5. Click Nortel.nab and then click the Open button.

6. Click the Add button to install the Norstar Voice Mail Desktop Messaging 
Folders. 
The Norstar Voice Mail Desktop Messaging Folders are now installed into
directory and are part of your information services.

7. Select Nortel Folders from the list and click the OK  button.
The Create/Open Personal Folders File dialog box appears.

8. Move to the destination directory where you want to put the Norstar Voice
Mail Desktop Messaging Folders. Put the Norstar Voice Mail Desktop 
Messaging Folders in the folder where you installed the Norstar Voice Mai
Desktop Accessories software.

9. In the File name box, type NortelMS.pst and click the Open button.
Desktop Accessories Software Installation Guide P0908823 Issue 01
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10. Click the OK button to accept the default settings for the Norstar Voice Ma
Desktop Messaging Folders. 
The MS Exchange Settings Properties dialog box appears, with Norstar V
Mail Desktop Messaging Folders added to the list.

11. Click the Add button. A list of available information services is displayed

12. Select Nortel Messaging and click the Add button to add Norstar Voice Mail 
Desktop Messaging to the information service directory.

13. Select Nortel Messaging and click the OK  button. Norstar Voice Mail 
Desktop Messaging is now installed.

14. Select Norstar Voice Mail Desktop Messaging and click the Delivery tab.

15. Select Nortel Folders and click the up arrow key to move Nortel Folders to 
the top of the list and then click the OK  button.

If you have a single messaging profile, the MAPI profile is configured and Nor
Voice Mail Desktop Messaging is ready to use.

If you have multiple messaging profiles, continue with "Configuring multiple 
MAPI profiles" on page 8.
P0908823 Issue 01 Desktop Accessories Software Installation Guide
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Configuring multiple MAPI profiles
If your PC has multiple messaging profiles, you must configure each messag
profile you intend on using to access the Norstar Voice Mail Desktop Messag
software. You can skip any messaging profiles that do not have network 
connections.

To configure multiple MAPI profiles:

1. On the taskbar, click Start, point to Settings and then click Control Panel.
The Control Panel window opens.

2. Double-click the Mail and Fax icon.
Your Properties dialog box is displayed.

3. Click the Show Profiles button.
The Mail and Fax dialog box appears with a list of the profiles set up on th
computer. 

4. Click the profile you want to configure, and then click the Properties button.
The Properties dialog box appears for the selected profile. 

5. Repeat the steps in "Configuring the Messaging Application Program 
Interface (MAPI) profile" on page 6 to add the Nortel Address Book, Norte
Folders and Nortel Messaging to the messaging profile.

You are ready to use Norstar Voice Mail Desktop Messaging.
Desktop Accessories Software Installation Guide P0908823 Issue 01
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Starting the Norstar Voice Mail Desktop Accessories software
To start the Norstar Voice Mail Desktop Accessories software:

1. On the taskbar, click Start, then click Programs, and then click Norstar 
Desktop Messaging.

2. Click the Norstar Desktop Accessories feature you want to use.

Note: If you select Norstar Voice Mail Operator Manager, you must enter 
Operator password (ƒ·°¤ password). 

Removing the Norstar Voice Mail Desktop Accessories software from a 
PC

You can remove the Norstar Voice Mail Desktop Accessories software from y
PC any time. Before you remove the Norstar Voice Mail Desktop Accessories
software, you must remove all Norstar Voice Mail Desktop Messaging referen
from the messaging profiles.

Removing the Norstar Voice Mail Desktop Messaging references from the 
messaging profiles

To remove the Nortel Address Book, Nortel Folders and Nortel Messaging fro
your messaging profile:

1. On the taskbar, click Start, point to Settings and then click Control Panel.
The Control Panel window opens.

2. Double-click the Mail and Fax icon.
Your Properties dialog box appears.

3. In the list, click Nortel Messaging and then click the Remove button. A 
message appears asking you to confirm the deletion. 

4. Click the Yes button to confirm the deletion.

5. In the list, click Nortel Folders and then click the Remove button. A message 
appears asking you to confirm the deletion. 

6. Click the Yes button to confirm the deletion.

7. In the list, click Nortel Address Book and then click the Remove button. You 
are asked to confirm the deletion. 

8. Click the Yes button to confirm the deletion.

If you have configured multiple MAPI profiles, you must repeat this procedure
each profile.
P0908823 Issue 01 Desktop Accessories Software Installation Guide
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Removing the Norstar Voice Mail Desktop Accessories software
To remove the Norstar Voice Mail Desktop Accessories software:

1. On the taskbar, click Start, point to Settings, and then click Control Panel.
The Control Panel window opens.

2. Double-click the Add/Remove Programs icon.
The Add/Remove Programs Properties dialog box appears.

3. In the list, click Nortel Desktop Messaging and then click the Add/Remove 
button. A message appears asking you to confirm the deletion. 

4. Click the Yes button to confirm the deletion. The Uninstall program takes 
several seconds to remove the Norstar Voice Mail Desktop Accessories 
software.

5. Click the OK  button.
The Norstar Voice Mail Desktop Accessories software is now removed fro
your PC.
Desktop Accessories Software Installation Guide P0908823 Issue 01
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Welcome to Norstar Voice Mail Desktop 
Messaging

About Norstar Voice Mail Desktop Messaging
Norstar Voice Mail Desktop Messaging gives you access to voice messages from yo
personal computer. You can manage all your voice, fax and e-mail messages in one
graphical interface. You can access your mailbox from your telephone at any time.

In Norstar Voice Mail Desktop Messaging, you can send and receive messages that i
any combination of voice, fax and text. Here are some of the many ways you can us
Norstar Voice Mail Desktop Messaging:

• Listen to voice messages

• View and print fax messages

• Record and send voice messages

• Create and send fax messages

• Forward and reply to voice and fax messages

• Add message options such as urgent and private

• Add voice, fax or text file attachments to messages

• Create personal distribution lists

• Change your password

Refer to the online Help available with Norstar Voice Mail Desktop Messaging for deta
information not covered in this Quick Reference Guide.

This Guide shows examples in Microsoft Outlook. The way your screen looks can va
Microsoft Exchange.

System requirements
To record and play Norstar Voice Mail Desktop Messaging voice messages from yo
computer, you computer must have:

• a sound card

• a microphone

• speakers

To use any of the fax options, your system must have the Norstar Voice Mail FAX op
installed. Ask your System Administrator to install this option.
P0908824 Issue 01 Norstar Voice Mail Desktop Messaging Quick Reference Guide
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Logging on

Use your Enterprise Edge password to log on to Norstar Voice Mail Desktop Messa

Remote log on
You can log on to Norstar Voice Mail Desktop Messaging from another computer, su
your laptop, if Norstar Voice Mail Desktop Messaging is installed and configured in t
same way as your office computer. You can work offline and use a dial-up connectio
reach the server.

To log on from your PC

1. On your desktop, click the Microsoft 
Outlook icon.
The Nortel Messaging Logon dialog 
box appears.

2. In the Mailbox  box, type your 
mailbox or extension number.

3. In the Password box, type your 
password.

4. Click the OK  button.
The Microsoft Outlook window 
appears.

Shortcut log on

1. Right-click the mailbox icon on the 
Windows taskbar and then click 
Open Inbox.
The Nortel Messaging Logon dialog 
box appears.

2. In the Mailbox  box, type your 
mailbox or extension number.

3. In the Password box, type your 
password.

4. Click the OK  button.
The Microsoft Outlook window 
appears.
Norstar Voice Mail Desktop Messaging Quick Reference Guide P0908824 Issue 01
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Changing your Enterprise Edge Voice 
Messaging password

You can change your Enterprise Edge password from Norstar Voice Mail Desktop 
Messaging.

To change your Enterprise Edge 
password from Microsoft Exchange 
or Microsoft Outlook

1. On the Outlook window, click Tools 
and then click Norstar Mailbox  
Manager.
The Norstar Mailbox Manager 
window appears.

2. Click the Password tab.

3. In the Current Password box, type 
your current password.

4. In the New Password box, type your 
new password.

5. In the Verify Password box, type 
your new password.

6. Click the OK  button.
P0908824 Issue 01 Norstar Voice Mail Desktop Messaging Quick Reference Guide
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Norstar Voice Mail Desktop Messaging for 
Microsoft Exchange and Outlook

When you open Microsoft Exchange or Microsoft Outlook, display your Norstar Voic
Mail Desktop Messaging messages by clicking the Inbox icon under the Nortel Netw
icon. From the Inbox you can move, copy and delete messages, and create new me
 

When you 
delete a 
message, it 
is moved to 
Deleted 
Items. To 
delete 
messages 
completely, 
empty the 
Deleted 
Items folder. 

Nortel 
Folders 
contain your 
received, 
sent and 
deleted 
Norstar 
Voice Mail 
Desktop 
Messaging 
messages

Date and 
time 
received

Subject 
shows the 
sender’s 
phone 
number, 
and if the 
message is 
voice, fax 
or text. 

To open a message, 
double-click the 
message icon

New messages 
appear in bold

Click the New Mail 
Message icon to 
create a new message

A paperclip means that 
the message has an 
attached file

An exclamation mark means that 
the message is urgent

Click the Address 
Book icon to access 
the address books
Norstar Voice Mail Desktop Messaging Quick Reference Guide P0908824 Issue 01
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Reviewing your messages

To play Norstar Voice Mail Desktop Messaging voice messages from your computer,
computer must have a sound card and speakers.

Message notification
When you have a new message the mailbox icon on your Windows taskbar displays
exclamation mark. 
After you play your message, the exclamation mark disappears.
 

The Nortel Voice Player

To play a voice message

1. Double-click the voice message icon 
in the Norstar Voice Mail Desktop 
Messaging Inbox.
The message appears in a separate 
window.

2. Double-click the Voice Message icon 
to play the voice message.
The Nortel Voice Player appears.

Fast forwards 
the message

Plays the message

Pauses the 
message

Stops playing the 
message

Downloads and 
plays the voice 
message

Closes the 
Play bar

Rewinds the 
message
P0908824 Issue 01 Norstar Voice Mail Desktop Messaging Quick Reference Guide
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To view a fax message
To view faxes in Norstar Voice Mail Desktop Messaging you must have Imaging for 
Windows installed on your PC. To use any of the fax options, your system must hav
Norstar Voice Mail FAX option installed. Ask your System Administrator to install thi
option.

While you view the fax, you can enlarge or reduce the image, rotate it, move it, copy 
print it.

To view a fax message

1. Double-click the fax message icon in 
the Norstar Voice Mail Desktop 
Messaging Inbox.
The message appears in a separate 
window.

2. Double-click the Fax Message icon to
view the fax message.

3. Save the fax message to the desired 
location.

4. Double-click the fax message icon to 
open it. The fax message is displayed
in Imaging for Windows.

Save Print Drag/
scroll

Annotate Zoom in
Zoom out

Rotate left
Rotate right

Magnification Previous page
Current page
Next page

One page view
Thumbnail view
Page & thumbnail view
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Creating messages

You can create a message that is any combination of voice, fax or text. Your messa
be a new message, a reply to a received message or an introduction to a forwarded m
Before you send your message, you can add attachments and options.

Create a voice message by opening an Norstar Voice Mail Desktop Messaging new
message and recording a message from your microphone. You can send the messa
save it to send later.

To record and send a voice message

1. On the Microsoft Exchange or 
Microsoft Outlook toolbar, click the 
New Mail  Message icon.
A new message window appears.

2. Click inside the body of the message.

3. Click the Insert menu and then click 
Object.
The Insert Object dialog box appears.

4. In the Object Type list, click Wave 
Sound.

5. Select the Create New option.

6. Click the OK  button.
The Sound Object dialog box opens.

7. Record your voice message and click
the Close button to return to your 
message.

8. Click the to button to open the 
address books and address your 
message.

9. Add the attachments and options you
require. See Adding attachments to 
messages on page 13 and Setting 
message options on page 16.

10. Click the Send icon to send your 
voice message.
P0908824 Issue 01 Norstar Voice Mail Desktop Messaging Quick Reference Guide
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To save a voice message
You can record a voice message and save it as a file to use later.

1. In an Norstar Voice Mail Desktop Messaging message, record a message.

2. On the File menu, click Save As.
The Save As dialog box appears.

3. In the File name box type a name for the file and in the Save as type list box 
select .rtf.

4. Select a folder to keep the file in and then click the Save button.
Norstar Voice Mail Desktop Messaging Quick Reference Guide P0908824 Issue 01
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To create and send a fax message
To send a fax, your system administrator must have installed Enterprise Edge FAX 
capability for your mailbox. The recipients of your fax must also have fax capability 
enabled to view the fax on their computer. If your recipients access their messages 
their telephone, they must print the fax to view it. You can send your fax to a fax mac
by entering the fax number as the address.

To send a fax message

1. Open the document that you want to 
fax. It must be 8.5 inches wide or 
less.

2. On the File menu, click Print .

3. From the list of printers, select Nortel 
Fax.

4. Click the OK  button.
The Compose Fax dialog box 
appears. From here you can view the 
fax, add more documents to the fax or
save the fax as a file.

5. Click the Send button.
The Optional Voice Annotation 
dialog box appears.

6. If you want to add a voice 
introduction to the fax, click the Yes 
button and record the voice message
or
if you want to send just the fax 
message, click the No button
or
if you want to cancel the fax, click the 
Cancel button.

7. On the Fax Message window, click 
the To button to select a recipient 
from your Personal Address book, or 
type the recipients’s e-mail address in
the To box.

8. Click the Send icon to send the fax.
P0908824 Issue 01 Norstar Voice Mail Desktop Messaging Quick Reference Guide
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To create and send a text message

1. Open an Norstar Voice Mail Desktop Messaging new mail message.

2. Type or paste text into the message and then click the Send button.

To save a text message

1. On the File menu, click Save As.
The Save As dialog box appears.

2. In the File name box type a name for the file and in the Save as type list box 
select .rtf.

3. Select a folder to keep the file in and then click the Save button.
Norstar Voice Mail Desktop Messaging Quick Reference Guide P0908824 Issue 01
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Forwarding and replying to messages

You can forward a message and create an introduction to send with it. You can crea
reply to the sender of a message, or to the sender and all recipients of a message.

To forward or reply to a message

1. Open the message you want to forward or reply to.

2. If you want to forward the message, click the Forward icon and address the messag
or
if you want to reply to the sender of the message, click the Reply icon 
or 
if you want to reply to the sender and all the recipients of the message, click the 
Reply to all icon.

3. Click the Send button.

Adding attachments to messages

Before sending a message, you can attach a voice, fax or text file to it. Text files mu
.txt files and fax files must be .tif-f files. 

To attach a file to a message

1. In an open message, click the Insert 
File icon.
The Insert File dialog box appears.

2. Type the name of the file that you 
want to attach in the File name box 
and click the OK  button, or double-
click the file’s icon to attach it.

3. In the Insert as option, select 
Attachment.

4. Click the Send icon.
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Addressing messages

With Norstar Voice Mail Desktop Messaging you can address a message by selectin
name from the Nortel Address Book or your Personal Address Book. Your Personal
Address Book can include distribution lists and names.

To add a Nortel Address Book 
address to your Personal Address 
Book

1. On the Microsoft Outlook or the 
Microsoft Exchange toolbar, click the 
Address Book icon.
The Address Book dialog box 
appears.

2. In the Show Names from the: list 
box select Nortel Address Book.

3. Select the name you want from the 
Nortel Address Book and click the 
Properties button.
The Properties dialog box for the 
name you selected appears.

4. Click the Personal Address Book 
button and then click the OK  button 
in the next two dialog boxes to add 
the name to your Personal Address 
Book.
Norstar Voice Mail Desktop Messaging Quick Reference Guide P0908824 Issue 01
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To address a message from the 
Nortel Address Book or your 
Personal Address Book

1. On the Microsoft Outlook or 
Microsoft Exchange toolbar, click the 
Address Book icon.
The Address Book dialog box 
appears.

2. In the Show Names form the list box, 
select Nortel Address Book or 
Personal Address Book.

3. Select the name of the recipient or a 
distribution list.

4. Click the To button.

5. Click the OK button to return to the 
message window.
P0908824 Issue 01 Norstar Voice Mail Desktop Messaging Quick Reference Guide
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Setting message options

From a Norstar Voice Mail Desktop Messaging message window you can set priorit
sensitivity and delivery options.

On the open message window click File and then click Properties.
The Properties dialog box appears.

Sets the value of the 
message to Low, 
Normal or High 

Notifies you when 
the message has 
been read

Notifies you of 
delivery

Saves a copy of the 
message to your Sent 
Message folder

Sets the sensitivity of 
the message to 
Normal, Personal, 
Private or 
Confidential
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Creating personal distribution lists

You can create a personal distribution list for a group of persons that you often send
messages to. After you create a list, it appears in your Personal Address Book. Whe
want to address a message to the group, select the list..

To create a personal distribution list

1. On the Microsoft Outlook or 
Microsoft Exchange toolbar, click the 
Address Book icon.
The Address Book dialog box 
appears.

2. Click the New Entry icon.
The New Entry dialog box appears.

3. In the list of entry types, select 
Personal Distribution List and click 
the OK  button.
The New Personal Distribution List 
Properties dialog box appears.

4. In the Name box type the name of the 
distribution list.

5. Click the Add/Remove Members 
button and type or select members 
from the list to add to your new 
personal distribution list.

6. Click the OK button in the current 
and the next dialog boxes to create 
your new personal distribution list.
P0908824 Issue 01 Norstar Voice Mail Desktop Messaging Quick Reference Guide
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	1. On the Microsoft Exchange or Microsoft Outlook toolbar, click the New Mail Message icon. A new...
	2. Click inside the body of the message.
	3. Click the Insert menu and then click Object. The Insert Object dialog box appears.
	4. In the Object Type list, click Wave Sound.
	5. Select the Create New option.
	6. Click the OK button. The Sound Object dialog box opens.
	7. Record your voice message and click the Close button to return to your message.
	8. Click the to button to open the address books and address your message.
	9. Add the attachments and options you require. See Adding attachments to messages on page 13 and...
	10. Click the Send icon to send your voice message.

	To save a voice message
	1. In an Norstar Voice Mail Desktop Messaging message, record a message.
	2. On the File menu, click Save As. The Save As dialog box appears.
	3. In the File name box type a name for the file and in the Save as type list box select .rtf.
	4. Select a folder to keep the file in and then click the Save button.
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	To send a fax message
	1. Open the document that you want to fax. It must be 8.5 inches wide or less.
	2. On the File menu, click Print.
	3. From the list of printers, select Nortel Fax.
	4. Click the OK button. The Compose Fax dialog box appears. From here you can view the fax, add m...
	5. Click the Send button. The Optional Voice Annotation dialog box appears.
	6. If you want to add a voice introduction to the fax, click the Yes button and record the voice ...
	7. On the Fax Message window, click the To button to select a recipient from your Personal Addres...
	8. Click the Send icon to send the fax.

	To create and send a text message
	1. Open an Norstar Voice Mail Desktop Messaging new mail message.
	2. Type or paste text into the message and then click the Send button.

	To save a text message
	1. On the File menu, click Save As. The Save As dialog box appears.
	2. In the File name box type a name for the file and in the Save as type list box select .rtf.
	3. Select a folder to keep the file in and then click the Save button.
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	To forward or reply to a message
	1. Open the message you want to forward or reply to.
	2. If you want to forward the message, click the Forward icon and address the message or if you w...
	3. Click the Send button.


	Adding attachments to messages
	To attach a file to a message
	1. In an open message, click the Insert File icon. The Insert File dialog box appears.
	2. Type the name of the file that you want to attach in the File name box and click the OK button...
	3. In the Insert as option, select Attachment.
	4. Click the Send icon.


	Addressing messages
	To add a Nortel Address Book address to your Personal Address Book
	1. On the Microsoft Outlook or the Microsoft Exchange toolbar, click the Address Book icon. The A...
	2. In the Show Names from the: list box select Nortel Address Book.
	3. Select the name you want from the Nortel Address Book and click the Properties button. The Pro...
	4. Click the Personal Address Book button and then click the OK button in the next two dialog box...

	To address a message from the Nortel Address Book or your Personal Address Book
	1. On the Microsoft Outlook or Microsoft Exchange toolbar, click the Address Book icon. The Addre...
	2. In the Show Names form the list box, select Nortel Address Book or Personal Address Book.
	3. Select the name of the recipient or a distribution list.
	4. Click the To button.
	5. Click the OK button to return to the message window.
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	To create a personal distribution list
	1. On the Microsoft Outlook or Microsoft Exchange toolbar, click the Address Book icon. The Addre...
	2. Click the New Entry icon. The New Entry dialog box appears.
	3. In the list of entry types, select Personal Distribution List and click the OK button. The New...
	4. In the Name box type the name of the distribution list.
	5. Click the Add/Remove Members button and type or select members from the list to add to your ne...
	6. Click the OK button in the current and the next dialog boxes to create your new personal distr...




